
HABITAT cell
HABITAT photo cell
HABITAT cell cct
HABITAT photo cell cct

HABITAT cell vessel
0.5 L sw
0.5 L dw
1 L sw
1 L dw
2 L sw
2 L dw
5 L sw
5 L dw
10 L dw

HABITAT ferment vessel
0.5 L dw
1 L dw
2 L sw
2 L dw
5 L sw
5 L dw
10 L dw

HABITAT ferment
HABITAT photo ferment
HABITAT ferment cct
HABITAT photo ferment cct
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Explication of warning symbols

EU Declaration of conformity

/// Warning symbols

/// General Symbols

Note
Indicates steps of actions that require particular attention.

Position number
Indicates device components relevant to actions.

A–––

Correct / result
Indicates the correct execution or the result of an action step.

Wrong
Indicates the incorrect execution of an action step.

We declare under our sole responsibility that this product corresponds to the directives 2014/35/EU,
2006/42/EC, 2014/30/EU and 2011/65/EU and conforms with the following standards or 
normative documents: EN 61010-1, EN 61010-2-051, EN 61326-1, EN 60529 and EN ISO 12100.
Bluetooth® module:
Directive: 2014/53/EU         Standards: EN 60950-1, EN 300328, EN 301489-1, EN 301489-17

A copy of the complete Declaration of Conformity or further declarations of conformity can be 
requested at sales@ika.com.

Source language: German

Indicates an (extremely) hazardous situation, which, if not avoided, will 
result in death, serious injury.

Danger!

Indicates a hazardous situation, which, if not avoided, can result in 
death, serious injury.

Warning!

Indicates a potentially hazardous situation, which, if not avoided, can 
result in injury.

Caution!

! Indicates practices which, if not avoided, can result in equipment dam-
age.

Notice!

/// General information

› Read the operating instructions completely before starting up and follow the 
safety instructions.

› Keep the operating instructions in a place where it can be accessed by everyone. The 
operating instructions are also available as a PDF or can be downloaded from the user 
interface and also from the IKA homepage.

› Ensure that only trained staff work with the device.
› Follow the safety instructions, guidelines, occupational health and safety and accident 

prevention regulations.
› The device must only be used in a technically perfect condition.

!  Notice!
› Pay attention to the marked sites in Fig. 1.

Safety instructions

/// Device design

  Caution!
› The power switch of the device must be accessed immediately, directly and without risk at 

any time. If access to the power switch cannot be ensured, an additional emergency stop 
switch that can be easily accessed must be installed in the work area.

› Ensure that your hands / fingers do not get crushed when setting down the device.

 Caution!
› Device surface is partially made of glass:

- Glass surface can be damaged by impact.
 - If glass surface is damaged it could cause injury, don`t use the device anymore.

!  Notice!
› Set up the device in a spacious area on an even, stable, clean, non-slip, dry and fireproof 

surface.
› The feet of the device must be clean and undamaged.
› Ensure that the vessel stands safely on the device.

!

Indicates the exposure to a hot surface.Danger!

/// Working with the device

  Danger!
› Do not use the device in explosive atmospheres, it is not EX-protected.
› With substances capable of forming an explosive mixture, appropriate safety measures must 

be applied, e.g. working under a fume hood.
› To avoid body injury and property damage, observe the relevant safety and accident 

prevention measures when processing hazardous materials.
› Before use, the vessel system has to be cleaned and sterilized.
› The device is not suitable for hand-held operation.
› Do not touch the rotating parts during operation!
› Autoclaving: 121 °C / 25 ... 30 minutes
 Do not close the hose jacket connectors for the temperature chamber of the double-wall 

glass vessel while autoclaving! The vessel might get broken! Be aware of the hot surface after 
autoclaving!

› Turn off the peristaltic pumps before replacing any tubes or pump heads.
› During autoclaving, there must be no water in the condenser. Fill the condenser with water 

only after autoclaving! For autoclaving remove the filling screw of the condenser.

Indicates crushing risk to fingers / hands.Caution!

Closed lock
Indicates the status of “locked”.

Open lock
Indicates the status of “Unlocked”.
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/// Accessories

› Protect the device and accessories from bumping and impacting.
› Check the device and accessories for damage before each use. Do not use damaged com-

ponents.
› Safe operation is guaranteed only with the use of original IKA accessories.
› Ensure that the external temperature sensor is inserted into the medium to a depth of at 

least 20 mm when connected.
› Observe the operating instructions of the accessories.

 Warning!
› Only process media that will not react dangerously to the extra energy produced through 

processing. This also applies to any extra energy produced in other ways, e.g. through light 
irradiation.

› Beware of hazards due to:
- flammable materials,
- glass breakage,
- overfilling of media,
- rotating parts.

› When handling hazardous substances or mixtures of substances which are toxic or 
are contaminated with pathogenic micro-organisms, the user should take appropriate 
precautions. Observe the national regulations, the biosafety level of your laboratory, the 
material safety data sheets.

› For germs or biological material or risk group II or higher, please observe the “Laboratory 
Biosafety Manual” issued by the World Heath Organization). 

› It may be possible for wear debris from rotating accessory parts to reach the material being 
processed.

› The operation of a free rotating shaft end is prohibited.
› Excessive or negative pressure can damage the glass reactor vessel.
› Do not use damaged hoses.
› Check all connections for leaks, especially all gas connections.

 Caution!
› Wear your personal protective equipment in accordance with the hazard category of the 

media to be processed. There may be a risk from:
- ejection of parts,
- release of toxic or combustible gases,
- splashing and evaporation of liquids,
- parts with hot surfaces.

› Stop operating if:
- the medium splashes out of the vessel because the speed is too high,
- the device is not running smoothly,
- the device begins to move around because of dynamic forces,
- an error occurs.

!  Notice!
› Remove the motor, the sensor cables and the foam sensor before autoclaving. Other parts are 

autoclavable.
› Cover the sensor connections during autoclaving (for example with aluminum foil).
› Covers or parts that can be removed from the device without tools must later be refitted to 

ensure safe operation. 
› There may be electrostatic activity between the medium and the output shaft which could 

cause a direct danger.
› Never operate the device with the stirrer tools rotating freely. Ensure that parts of the body, 

hair, jewelry or items of clothing cannot be trapped by the rotating parts.
› Pay attention when setting the speed to any imbalance of the stirrer tools and possible 

spraying of the medium to be stirred.

 Danger!
› Working with gases:

- Gases can be hazardous to the health.
- Observe the general safety instructions for the handling of gases!
- Carry out regular training of personnel for the handling of gases.
- When connecting the supply lines, ensure correct connections and the maximum 

permissible connection pressures!
- Only work with the original accessories, and check that they are in perfect condition 

before operating the device!
- Close the gas supply at the end of the experiment.
- Determine the possible concentration of the escaping gases at the outlet of the bioreactor.
- Use all the necessary gases only in the quantities required, and make sure that the 

atmosphere is not enriched with them.
- Ensure sufficient ventilation at the workplace.
- Observe the current safety data sheets for the gases used.

› Working with oxygen / O2:
- As a compressed gas, oxygen is oxidising; aids intensive combustion; can react violently 

with flammable materials.
- Observe the general safety instructions for the handling of gases (see above).
- The presence of oxygen reduces the ignition temperature and the necessary ignition 

energy of a combustion and increases the fire temperature.
- Keep possible ignition sources (open flames, hot surfaces) away.
- Do not use oils or greases in the area containing oxygen (fittings, connections).
- Use oxygen only in the quantities required, and make sure that the atmosphere does not 

become enriched with oxygen. 
- Ensure sufficient ventilation at the workplace.

› Working with nitrogen / N2:
- Nitrogen is odorless and leads to asphyxiation in high concentrations!
- Observe the general safety instructions for the handling of gases (see above).
- Do not use oils or greases in the nitrogenous area (fittings, connections).

› Working with carbon dioxide / CO2
- Carbon dioxide is a non-flammable, acidic and colorless gas. High concentrations can be 

fatal due to oxygen deficiency.
- Observe the general safety instructions for the handling of gases (see above).
- CO2 is produced during fermentation processes, among other things. Pay particular 

attention to good ventilation and connect the exhaust air duct of the bioreactor to a 
suitable extraction device.

- Keep this in mind when using larger quantities of CO2 for pH regulation.



10 11

Intended use

1 HABITAT cell / ferment

2 Tablet PC

3 Power cord set H 11 

4 Peltier cooling

5 USB Type-C Adapter

6 User guide

7 Warranty card

8

/// Area of use

› Indoor environments similar to that a laboratory of industry area.
› The safety of the user cannot be guaranteed:

- if the device is operated with accessories that are not supplied or recommended by the 
manufacturer,

-  if the device is operated improperly or contrary to the manufacture’s specifications,
- if the device or the printed circuit board are modified by third parties.

/// Use

› Bioreactors are designed to run cell growth or fermentation processes.

Unpacking

/// Unpacking

› Unpack the device carefully. Any damage should immediately be reported to the carrier (mail, 
rail or freight forwarding company).

/// Scope of delivery

1

/// Power supply / Switching off the device

 Warning! 
› After a power failure during operation, the device may start automatically (depending on the 

operating mode).
› Restart PC / App and the  IKA HABITAT software if a software failure occurs. IKA HABITAT will 

run without an active connection with PC / App.

› The voltage stated on the type plate must correspond to the mains voltage.
› The device can only be disconnected from the power supply by pulling out the mains plug 

or the connector plug. 
› The device must only be operated with the original power cord set.
› The socket for the power cord must be easily accessible.
› Socket must be earthed (protective ground contact).
› Replace the fuses only after disconnecting the device from the power supply by pulling out 

the mains plug. The fuse value must correspond to the value on the serial license plate.

/// Maintenance

› The device may only be opened by qualified and approved experts. The device must be 
unplugged from the power supply before opening. Live parts inside the device may still be 
live for some time after unplugging from the power supply.

› Only use original IKA spare parts!

/// Disposal instructions

› The device, accessories and packaging must be disposed of in accordance with local and 
national regulations.

safe
STOP

rpm Temp pH Do Level Foam

1

3

2 5

4

Warranty

FREE WARRANTY

 EXTENSION

HABITAT cell

HABITAT photo cell

HABITAT cell cct

HABITAT photo cell cct

HABITAT cell vessel

0.5 L sw
0.5 L dw

1 L sw
1 L dw

2 L sw
2 L dw

5 L sw
5 L dw

10 L dw

HABITAT ferment vessel

0.5 L dw
1 L dw

2 L sw
2 L dw

5 L sw
5 L dw

10 L dw
HABITAT ferment

HABITAT photo ferment

HABITAT ferment cct

HABITAT photo ferment cct

6

7



12 13

1 HA.vh.x vessel holder incl. HA.lc.x lid 
mounted

2 HA.gv.sw.x (vessel single wall) or HA.gv.dw 
(vessel double wall)

3 HA.mt.s.x (Motor)

4 HA.sp.m.x (Micro sparger) or HA.sp.r.x* (Ring 
sparger)

5 HA.cn (Condenser)

6 HA.ip.pi.x (Impeller 3-pitch blade) or 
HA.ip.b.x* (Impeller 6 blade) (for vessel size 
5 / 10 L, 2x) 

7 HA.ba.x (Baffle)*

8 HA.s.tm.x (Temperature sensor)

9 HA.s.ph.x (pH sensor)

10 HA.s.do.x (DO sensor)

11 HA.s.fo (Foam sensor)

12 HA.hbl.x (Heat blanket)

13 HA.cab.sw (cable set for single wall) or 
HA.cab.dw (cable set for double wall)

14 HA.sf.250 (Bottle 250 ml x4)

15 HA.sam (Syringe set)

16 HA.cf.x (Cooling finger)** 

17 Tool set

Note: "x" refers to the number of the vessel size like 0.5, 1, 2, 5 or 10, e.g. 2 L « HA.gv.sw.2; 0.5 L « HA.gv.sw.0.5.
Abbreviations:
sw: single wall
dw: double wall 

2

   HA.cab.sw

   or

   HA.cab.dw

16 17
**

* *

432

   For ferment only            For SW 2&5 L ferment only

or

or

or

5 6 7 9

13

14 15

10 11 12

8

*

* **

1

19 mm

17 mm

10 mm
10 mm

14 mm

16 mm

18 mm

8 mm

12 mm

15 mm

3.2 mm 4.8 mm

0.9 mm
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Useful information

› The HABITAT is operated with an iOS Tablet PC (included in the scope of delivery).
› Alternatively, the operation is also available via an MS-Windows® PC / notebook.
› Wired and wireless operation is supported. Monitoring is also available for an iOS mobile 

system by means of the Bioreactor App.
› During the process, the Tablet PC or notebook can be decoupled from the device. The device 

works independently of the user interface software. All data is stored in the device.
› The status of the main device parameters is indicated by a LED bar. (see "Alarm setting")
 Green LED: ok, within the limit values
 Orange LED: not ok, out of the limit values
 Red LED: not ok, an error has occurred
› When the Tablet PC / notebook is reconnected, all data from the device is transferred to the 

software of the Tablet PC / notebook and displayed.
› Safe-STOP button: Immediately pause all actuators (Stirrer, Heater, Pumps, MFCs / Mass-

flow Controllers, Thermostat, Light panel). 
 Safe-STOP: Press the button at the control unit / or the button on GUI. All actuators stop.
 Exit Safe-STOP: Press the button on the control unit again (not in the software). All actu-

ators are switched on again according to the settings.
› Mains switch: Switch on / off the device
 Power-ON: Control unit on, ready to start
 Power-OFF: Control unit off, no power supply

safe
STOP

Stirrer Temp pH pO2 Level Foam

Stirrer Temp pH pO2 Level Foam

safe
STOP

!

Mains switch
1 Filter (2x)

2 Filter heater

3 Plug in barb connector 6 mm x 5 mm (8x)

4 Hose reducer 6.4 mm x 3.9 mm (2x)

5 Y hose connector 3.2 mm (3x)

6 Silicone tube 3.2 mm x 6.4 mm x 7.5 m

7 Silicone tube 4.8 mm x 9.5 mm x 3 m 

8 Y hose connector 4.8 mm (3x)

9 PUN tube OD 6 mm x 10 m

10 Filter (4x)

11 pH cable

12 DO cable

13 USB cable

14 RS 232 cable

15 Hose clamp (5x)

16 Silicone cap (4x)

17 Twist tie (10x)

18 Hose with GL18 and quick coupling (2x)

19 Silicone tube 8 mm x 12.7 mm x 5 m

20 Hose clamp (4x)

8

3

   HA.cab.sw

18 19 20

12

16 17151413

5

9

   HA.cab.sw

   HA.cab.dw

31 2

11

4

6

10

7 8

!  Notice!
› The data log file is only active after the "Experiment" has been started. After pressing the 

"Play" menu button in the software, all data from "Start" to "Stop" are recorded. An experi-
ment can only be created with a a single name. 

› In safe-STOP mode, the data will continue to be recorded. The log file shows that all actu-
ators have been stopped for the duration of the safe-STOP. 
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Installation

/// Gas

A USB USB connection (data storage)

B PC PC connection (communication with GUI software)

C RS-232 RS 232 connection (communication with GUI software)

D ETHERNET Ethernet connection (communication with GUI software)

E SU-CONNECT Sensor connection SU Vessel

F LIGHT Light panel connection

G THERMOSTAT Thermostat connection

H EXT. PUMP External pump connection

I EXT. SIGNAL Connection 4....20 mA 

J PELTIER Peltier cooling connection

K FILTER HEATER Filter heater connection

L HEAT BLANKET Heat blanket connection

M STIRRER Stirrer connection 

N POWER SOCKET Power supply connection

O FUSE SOCKET Position of fuses

/// Interfaces

1.

2.

3.

1.

1.

1.

Max. 1.0 barg
Barb 5 mmOutlet

Max. 3.0 barg
Tube OD 6 mm

Inlet

A

B

C

D
E
F

G

H

I

J
K

N

L

O

M
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/// Vessel

/// Lid

Ports
Port sizes

0.5 L 1 L 2 L 5 L 10 L

Temp M10

DO Pg13.5

Level M12

Baffle 11 mm

pH Pg13.5

Exhaust cooler M16

Harvest M10

Sparger 11 mm

Feed 11 mm (x2) - - - -

4in1/Feed - M27

Cooling finger - - M27

Inoculation - 11 mm (x1) 11 mm (x1) 11 mm (x1) 11 mm (x1)

Reserve Pg13.5 - x1 x2 x3 x4

Reserve 11 mm - x1 x1 x1 x2

Reserve M27 - - - - x1

0.5 L 1 L

2 L 5 L

10 L

   Double-wall glass vessel

   Single-wall glass vessel

0.5 L

0.5 L

1 L

2 L

5 L

10 L

1 L

2 L

5 L
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/// Lid with plugs and fittings

/// Ring or micro sparger

/// Harvest pipe

10 mm
10 mm
15 mm
18 mm
10 mm

10 mm

3.2 mm

10 mm
10 mm

10 mm

10 mm

10 mm

/// Impeller

/// Drive shaft

1.

1.

2.

1.

4. 3.

2.

4.8 mm

1.

2.

2.

1.

3.

10 mm

Hold3.

10 mm

Turn3.
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/// Condenser

/// Baffle

 Danger!
› During autoclaving, there must be no water in the condenser. Fill the condenser with water 

only after autoclaving! For autoclaving remove the filling screw of the condenser.

/// Level sensor /// Temperature sensor

/// DO, pH, CO2, conductivity or turbidity probe

 Caution!
› Read the operating instructions for the 
 probes carefully!

!  Notice!
› Related on the lid size the ports may vary!

1.

2.17 mm

Turn2.

2.

3.

1.

10 mm

Turn3.

3.

4.

1.

2.

17 mm

Turn4.

10 mm

Turn1.

1.

2.

1.

2.
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!  Notice!
› Check the presence of the lid sealing. Never work without the lid seal. Risk of glass breakage.

/// Vessel and stand

/// Lid and vessel

3.

3.

3.

2.

1.

/// Spin filter (accessories)

2.

1.

3.

4.

6.

5.

7.

8.

(accessories)
HA.fi.x

1 2

3 4

10 mm

Turn3.

10 mm

Hold3.
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/// Peltier cooling

/// Motor

!  Notice!
› The Peltier cooling may only be used in conjunction with the IKA HABITAT.

1.

2.

/// Foam sensor
› Blue LED ON: Good alignment between sensor boxes, and no foam present.
› Blue LED OFF: Poor alignment between sensor boxes, or with obstructions in LED field of view.

7.3.

1.

2. 5.

6.

4.
2x

8.
2x

Left

Right
Right

Left

Foam sensor setup

ON OFF

Control tower

Level sensor

1 2

3

1

2

3

Cable connection

1.

1.
1.

2.
2.

3.
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 Warning!
› Ensure that the electrical equipment is in good condition before use. 
› For a long service life: Do not cut or fold!
› Store the heat blanket in a flat condition.
› Only for the use with single-walled reactor vessels!

/// Heat blanket

 Close tightly!

/// Pump tubing
› Flow rate

Tube ID
Flow rate (cc/min)

Pump head adjustment
min. max.

0.5 mm 0.3 4 A

0.8 mm 1.0 12 A

1.2 mm 1.6 20 A

1.6 mm 3.0 45 A

2.4 mm 7.0 85 B

3.2 mm 13.3 140 B

4.8 mm 26.6 270 B

› Adjust the pump head

› Insert the tube to the pump head

2 3

5

1

4

Marking
  (        )

1.
2.

A B

A

/// Twist tie

pH
Level / Foam
DO
Temp

pH
Level / Foam 
DO
Temp
BNC

pH + DO+ Temp + BNC

pH + Level / Foam + DO+ Temp

Motor + Filter heater

pH + Level / Foam + DO+ Temp

Motor

Filter heater

1

2
3

3

4

1 2 3 4
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/// Hose connecting

/// HA.ep External peristaltic pump (accessories) /// Connecting gas outlet to sparger

› Keep the hose connection as short as possible.

› Refer to the operating instructions of HA.ep.

Flask stand 
(HA.sfr.250, accessories)

Plug in barb connector
6 mm x 5 mm

Y hose connector
4.8 mm

Silicone tube 
4.8 mm x 9.5 mm x 3 m

11

1

22

2 2 2

2

2

Filter
3

3

3

4

4 4

PUN

PUN

PUNPUN tube 

OD 6 mm x 10 m 1

Hose reducer 
6.4 mm x 3.9 mm

2

Silicone tube 
4.8 mm x 9.5 mm x 3 m 3

Filter
4

Y hose connector 
3.2 mm 5

1

1

5
1 5 1 2

3

4

3

2
3

4

3

Connecting gas outlet to sparger: with PUN tube

Connecting gas outlet to sparger: with barb connector

PUN PUN

ONOOONNNNOONO
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/// Lid stand (accessories)

3.

While in use

While not in use

orHA.ls.2 HA.ls.10

2.

4.

1.

1.

!

!

/// Schematic view - 4 gases system

Abbreviation Description

FS Flow Sensor

CV Check Valve

FVC Flow Control Valve

PRV Pressure Relief Valve

F Filter

FM Foam Sensor

HBL Heat Blanket

pO2 DO Sensor

Abbreviation Description

pH pH Sensor

Level Level Sensor

Temp Temperature Sensor

CO2* CO2 Sensor

Cond* Conductivity Sensor

Turb* Turbidity Sensor

FH Filter Heater

1 bar

FS

0...2000 ccm** 
FVC

PRVAir 3 bar max CV

1 bar

FS

0...2000 ccm** 
FVC

PRVN2 3 bar max CV

1 bar

FS

0...2000 ccm** 
FVC

PRVO2 3 bar max CV

1 bar

FS

0...2000 ccm** 
FVC

PRVCO2 3 bar max CV

Pump Acid

F

Pump Base

Pump Foam

Pump Level

FH

FM

H
B
L

H
B
L

FM

pO2

pH

Level

Temp

CO2*

Cond*

Turb*

* Accessories

** Cell growth 0...2000 ccm
    Ferment 0...20000 ccm 

4 gases system / IKA HABITAT Cell growth & Ferment
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Operation

/// Switching on / off

1. Turn on the device by using the mains switch on the control unit.
2. Start tablet PC / laptop Bioreactor App.
3. Connect tablet PC / laptop via Ethernet, Wi-Fi or Serial port.

/// HABITAT "Quick start Guide"
1. iOS Installation
1.1 iPad Setup
› Set up your device for the first time or after having done a factory reset.
› For the setup of the iOs device (Apple iPad) please refer to the device setup information from 

Apple Inc.

1.2 Installing the HABITAT app
› Go to the App Store and search for "IKA HABITAT" or scan the QR code below to install the 

app.

› Click the link on your iOS device to install IKA HABITAT app 
 (https://apps.apple.com/us/app/ika-habitat/id1579608969)

QR code

App Store

1.3 Updating the application / app
› If an update of the IKA HABITAT app is available in the App Store, you will be notified.
 Note: If the IKA HABITAT app was installed by a previous user or already in the delivery state, 

the app must first be uninstalled and reloaded when changing accounts.

2. Getting start
2.1 Initial commissioning and setup
› First, turn on the IKA HABITAT, make sure that the device is ready for operation (all LEDs: 

green) and connected to the computer / Tablet PC via Wi-Fi or Serial connection / USB cable.
2.1.1 Connecting to the device (See "HABITAT Software connect Guide")

2.2 Logging in
› After initialization and synchronization between the operating software and the control unit, 

the opening screen shows the process view (main screen with reactor vessel and all process 
parameters and status).

› The user must log in to operate the device. The default user name and password is “admin”.
The password can be changed after the first login.

2.4 Changing "User ID" and "Password"
› Log in.
› Click the icon "User" and then the submenu 

“User Management”.
› In the "User Management" menu, click 

"Edit user", and then enter your new pass-
word.

2.5 Time synchronization
› After clicking the menu "Device time", a 

submenu opens with a confirmation dialog 
for time synchronization between the Tab-
let/PC and the control unit.

2.6 Exit the application
› Click on the icon "User" followed by “Quit”.

2.3 Setting the set points
› After clicking on a parameter values 

window, a submenu for setup and control 
settings appears.

2.3.1 Operating mode
› The user can select and set the operating 

mode for each component / controller:
- Off: Component / controller is off.
- Manual: Component / controller 
 operates according to the user's setpoint 

settings.
- Automatic: Component / controller 

operates according to the control 
 algorithms of the process conditions.
- Profile: Component / controller 
 operates according to predefined set 

points.

https://apps.apple.com/us/app/ika-habitat/id1579608969
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/// HABITAT "Software connect Guide"
1. Software connection (Windows version)
1.1 Components
› HABITAT control unit
› Laptop / PC with HABITAT software installed
› Cable (USB, RS-232, LAN) or Wireless (Wi-Fi) connection

1.2 Connection (4 options)
1.2.1 USB cable connection

1.2.2 RS-232 cable connection

› Open the IKA HABITAT software and select "Scan for new Device". 
- The software shows the available devices detected from the serial port.
- Click “Connect” to start the connection.

› Open the IKA HABITAT software and select "Scan for new Device".
- The software shows the available devices detected from the COM port.
- Click "Connect" to start the connection.

USB

RS 232

1.2.3 Ethernet / LAN cable connection

1.2.4 Wi-Fi connection

› Open the IKA HABITAT software and select "Scan for new Device".
- The software shows the available devices detected from the Ethernet port.
- Click "Connect" to start the connection.

- After data synchronization, the icon "Cable connection" is displayed.

- After data synchronization, the icon "LAN cable connection" is displayed.

EthernetEthernet

Same network
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› Open the IKA HABITAT software and select "Scan for new Device".
- The software shows the available devices detected from the Wi-Fi SSID:
 IKA_HABITAT_xxxxxxxx
- Click "Connect" and enter the Wi-Fi password “ikahabitat” (only necessary for the first 

connection) to start the connection.

- After data synchronization, the icon "Wi-Fi connection" is displayed.

2. App connection (iOS version)
2.1 Components
› HABITAT control unit
› iPad with HABITAT App installed (download from App store)
› Wi-Fi connection

2.2 Connection
 Wi-Fi connection from iPad to the control unit

› Enter the password “000000” (default password for logging in).
› Open the IKA HABITAT App and select "Connect to Wi-Fi… ".

› Connect to the HABITAT control unit via Wi-Fi SSID: IKA_HABITAT_xxxxxxxx-
- Enter the password “ikahabitat” (only necessary for the first connection) to start the connection.

› Select "Wi-Fi" setting.
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› Click to return to the IKA HABITAT App.

› Select "Scan for new Device".
- The software shows the available devices detected from Wi-Fi.
- Click "Connect" to start the connection.

- After data synchronization, the icon "Wi-Fi connection" is displayed.

IMPORTANT NOTE!
- Disable "Auto-join" for Wi-Fi connection to other devices to establish a stable connection 

between iPad and Control Unit.

- Enable the "Auto-join" only for pairing with the controller unit to establish a 
stable connection between iPad and control unit.

1

2

2

1
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2.3 iPad cable connection
› Backup solution for cable connection from iPad to the control unit

2.31 Components
1  Lightning Ethernet Adapter (with the charging port)
2  LAN cable

2.32 Connection
› Connect the iPad to the Ethernet Adapter.
› Connect the charging port of the control unit to the “USB-C” port of the Ethernet Adapter.
› Connect the Ethernet port of the control unit to the “Ethernet” port of the Ethernet Adapter.

1 2

› Set Ethernet connection for iPad (one-time setting):
1  Select "<…> Ethernet"
2  Select "USB 10/100 LAN"

3  Select “Configure IP”

1

2

3

Ethernet

Ethernet Adapter USB port
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4  Select “Manual”
5  Set the IP Address / Subnet Mask / Router:
    IP Address: 192.168.10.10
 Subnet Mask: 255.255.255.0
 Router: 192.168.10.251

6  “Save” the setting

› HABITAT software connect
1  Open HABITAT software
2  Select "…" at "Device Connection"
3  Select "Enter manually"
4  Select communication type as "Ethernet"
5  Define host name as "192.168.10.251"
6  Define port as "40999"
7  Then, click "Connect" 
 - After data synchronization, the icon "Ethernet connection" is displayed.

2

3

4

6

5

4

5

6

7

3. HABITAT App connect (Android version)
3.1 Components

› HABITAT control unit
› Android Tablet with HABITAT App installed (download from Play store)
› Wi-Fi connection

3.2 Connection
 Wi-Fi connection from Tablet to the control unit
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› Open HABITAT App, and select "Connect to Wi-Fi…".

› Connect to the HABITAT control unit via Wi-Fi SSID: IKA_HABITAT_xxxxxxxx
- Enter the password “ikahabitat” (only necessary for the first connection) to start the 

connection.
- Recommend to select "Always connect" (only necessary for the first connection).

› Click to return to the IKA HABITAT App.

› Select "Scan for new Device...".
- The software shows the available devices detected from Wi-Fi.
- Click "Connect" to start the connection.

- After data synchronization, the icon "Wi-Fi connection" is displayed.
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IMPORTANT NOTE!
› Disable "Auto-join" for Wi-Fi connection to other devices to establish a stable connection 

between Tablet and Control Unit.

› Enable the "Auto-join" only for pairing with the controller unit to establish a stable connec-
tion between Tablet and Control Unit.

2

1

1

2

/// Menu structure
Available 
Device

Scan for new Device

Enter manually Communication 
Type

Wi-Fi Host name

Port

Ethernet Host name

Port

Serial COM port

Baudrate

Connect to Wi-Fi

Main Screen User menu Login/Logout Username

Password

Device time Quit

User 
management

Show inactive user

System color Add new user Username

Email address

Status bar Password

Confirm Password

Safe-stop User enabled

User role Monitor

Process view Operator

Admin

Setup view Edit user Email address

Password

List view Confirm Password

User enabled

Trend view User role Monitor

Operator

Historical data Admin

Alarm

Maintenance

Settings

Info
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Process view Batch 
information

Batch ID

Name

Recipe

Status
Elapsed Time
Note

Start Button Start Cultivation Entering batch name
Entering note / comment
Choose recipe
Initialize batch
Start cultivation
Cancel

Air/O2/N2/CO2 Mode Off
Manual
Cascade - DO control
Profile Loop mode Stop

Set flow Continue with 
last setpoint
Repeat the loop

Start profile
Edit setpoint
Add setpoint
Insert setpoint
Delete setpoint

Acid/Base/ 
Anti-foam/ 
Feed-Level

Mode Off
Manual
Auto - pH control
Profile Loop mode Stop

Continue with 
last setpoint
Repeat the loop

Start profile
Edit setpoint
Add setpoint
Insert setpoint
Delete setpoint

Set flow

Set volume
Rotation Clockwise

Counterclockwise
Calibration 
information

Calibrate
Filling

Stirrer Mode Off
Manual
Cascade - DO control
Profile Loop mode Stop

Continue with 
last setpoint
Repeat the loop

Start profile
Edit setpoint
Add setpoint
Insert setpoint
Delete setpoint

Chaotic mixing Speed range in Chaotic mixing
Duration to run Chaotic mixing

Set speed
Rotation Clockwise

Counterclockwise
Exhaust Mode Off

Auto
Filter Heater

Foam limit Mode Off
Auto

On delay
On time
Sensitivity

Level limit Mode Off
Auto

On delay
On time
Sensitivity
Level control 
mode

Harvest
Feed

Temperature Mode Off
Auto
Profile Loop mode Stop

Continue with 
last setpoint
Repeat the loop

Start profile
Edit setpoint
Add setpoint

Set Temp. Insert setpoint
Set value offset Delete setpoint
Actuator Heating blanket

Thermostat
pH Mode Off

Auto
Profile Loop mode Stop

Continue with 
last setpoint
Repeat the loop

Start profile
Edit setpoint
Add setpoint

Set Temp. Insert setpoint
Set value offset Delete setpoint

pO2 Mode Off
Manual
Auto
Profile Loop mode Stop

Continue with 
last setpoint
Repeat the loop

Start profile
Edit setpoint
Add setpoint

Set pO2/ Set output Insert setpoint
Set value offset Delete setpoint

Light panel Mode Off
Auto
Profile Loop mode Stop

Continue with 
last setpoint
Repeat the loop

Start profile
Edit setpoint
Add setpoint
Insert setpoint

Light (%) Delete setpoint
Sample Data Sample Label

Sample Note
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Setup view General Batch mode Batch

Fed-batch

Perfusion

Select logging 
interval

5 sec
10 sec
30 sec
1 min
5 min
15 min
30 min

Select saving 
location

Internal
USB

Note
Reactor Vessel Single wall 0.5 L Glass

Single wall 1 L Glass
Single wall 2 L Glass
Single wall 5 L Glass
2 L normal SU
2 L optic SU
Double wall 0.5 L Glass
Double wall 1 L Glass
Double wall 2 L Glass
Double wall 5 L Glass
Double wall 10 L Glass

Sparger Ring sparger
Micro sparger

Propeller 6-blades disc
3-blades disc
Paddle stirrer

No. of propeller 0
1
2
3

Filter 50 mm, 0.22 Micron
50 mm, 0.45 Micron

50 mm, 1.0 Micron
Spinfilter 10 µm

20 µm
40 µm
75 µm

Baffles
Harvest pipe
Cooling finger

Pumps Pump A Acid
Pump B Base
Pump C Anti-foam
Pump D Feed/Level
Pump ExtA

Gases Air
O2
N2
CO2
Gas Mixer for mixing Air and O2

Controllers pO2 Cascading to Stirrer
Cascading to Air
Cascading to O2
Cascading to N2
Cascade setting +

-
Apply

List view Temperature Name

pH Actual value

pO2 Set value

Exhaust Unit
Stirrer Mode
Air Alarm enabled
O2 Alarm status
N2 Error
CO2
Acid
Base
Anti-foam
Level
Subs
Foam limit
Level limit
CO2 probe
Conductivity probe
Turbidity probe
Light panel

Select output 
path for Air

Overlay
Sparger
Overlay & Sparger

Select output 
path for O2

Overlay
Sparger
Overlay & Sparger

Select output 
path for N2

Overlay
Sparger
Overlay & Sparger

pH Cascading to Acid
Cascading to Base
Cascading to CO2
Select output 
path for CO2

Overlay
Sparger
Overlay & Sparger

Cell & Medium 
information

Cell information Name
Lot Number
Description

Culture medium Name
Lot Number
Description

Process 
supplement

Name
Lot Number
Description

Accessories & 
Option

Light Panel
CO2 sensor
Conductivity sensor
Turbidity sensor
Ext-A signal
Ext-B signal

Load Recipes Filter option Any column
Filter keyword Name column
Load Author column
Close

Save Save recipe Filter keyword
Save
Cancel

Clear
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Trend view Trend settings Enable

Plot Parameter Stirrer

Temp

pH
pO2
Acid
Base
Anti-foam
Level
Air
O2
N2
CO2
Light
CO2 probe
EC
Turbid

Plot Color

Zoom in

Zoom out Auto scaling
Scroll Min Y-Axis
Sync Max Y-Axis

Historical data Export to image

Review

Export to CSV

Generate report

Save to USB

Search Filter Keyword

Filter in Any column

Name column

Operator column

Start date column

Status column

Alarm #

Timestamp

Error code

Description

Value

Mantenance Sensor 
Calibration

Temp Last Calibration

Serial no.

Zero

Slope
Condition
Action CAL

pH Last Calibration
Serial no.
Zero
Slope
Condition
Action CAL

pO2 Last Calibration
Serial no.
Zero
Slope
Condition
Action CAL

Pump 
Calibration

Acid Last Calibration
Base Tubing ID
Afoam Set
Level Measure
SUBA k

Action CAL
Filling

Controller Temp kp
pH ki
pO2 kd

Action Reset
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Info About Device information

Firmware information

GUI software information

Disclaimer

IKA Cloud IKA Cloud Registration Information

Activate Cloud Communication

Go to: IKA Cloud

Manual

Video User guides

Shop

Settings General Device Name

Language System (system)

English (en_US)

Deutsch (de_DE)
中文 (zh_CN)
Español de españa (es_ES)
Française (fr_FR)
Italiano (it)
ไทย (th)

Select Mass flow unit
Down sampling Algorithm for Graph plotting
Auto restart after power failure

Alarm setting Enable
Lo limit
Hi Limit

System Factory default
Save setting
Upload setting
Device type Not set

HABITAT Cell
HABITAT Ferment
HABITAT Cell Photo
HABITAT Ferment Photo
HABITAT Cell CCT
HABITAT Ferment CCT
HABITAT Cell Photo CCT
HABITAT Ferment Photo CCT

Logging level Info
Debug

Log file to keep (days)
21-CFR Mode enabled

/// Menu navigation
1. Screen Format
1.1 Screen Layout Desktop / Tablet
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2. Screen List
2.1 Screen of all available devices
› To display all available devices that are discovered by the software via Networks (Ethernet, 

Wi-Fi Serial port and Bluetooth).

1.2 Screen Layout Mobile › Click on the plus sign "+" to open menu for re-scanning of new devices or entering the 
information to connect the device manually if it’s not discovered by the software.

› If the device is turned on, but not discovered by the software, you can enter the information 
manually to connect the device.
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› After successful data synchronization, the main screen shows the current status.
 A new log-in is not necessary.

2.2 Connection screen
› The software connects to the device and loads all necessary data.
› During data synchronization, the connection may be interrupted due to the poor connection 

quality or the invalid data.
› The software will show a corresponding error message.

2.3 Application Header Menu
2.3.1 Header TAB Button
› For screen navigation
1  Process view
2  Setup view
3  List view
4  Trend view

2.3.2 Safe-Stop
› The Safe-Stop (or Emergency) button is needed to stop all the running actions of the device. 

If the button flashes, the device is in the Safe-Stop mode, the Software is no longer connect-
ed to the device and after a short time the screen "Available devices" (2.1) is shown.

› To restart the operation, the Safe-Stop button on the control unit must be pressed.

2.3.3 System color
› The color indicates which control unit is connected to the Software.
› The system color is synchronized with the LED color on the front of the control unit. The 

color can be changed by clicking on the color icon.

2.4 Application Bottom Menu
1  Display current setup.
2  Current device time. Click to synchronize the device time with the Tablet / PC.

5  Historical data view
6  Alarm view
7  Maintenance view
8  Settings view
9  Info view 

1 2

1 2 3 4 5 6 7 8 9
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2.5 Process view
› Start screen with schematic illustration of the reactor vessel:

- Display of components of the current configuration
- Overview of measured values and process parameters
- Open the controller menus

1  Log-in user menu and user account (Add, Edit and Delete)
2  Connection status display of the currently selected connection type (Ethernet, Wi-Fi or Serial 

port)
3  Device color indicator
4  Safe-Stop
5  Device date / time
6  Experiment Start button (start data logging and auto mode functions)
7  Display selected recipe

1
4

3
2

5

6

7

2.5.1 Batch information display
› Display information of current / last batch, such as ID, name, rec-

ipe used, status, time elapsed and user information entered.

2.5.2 Login
› Before the user is able to change any parameters value or configuration, the user is required 

to log in to the device first.
› Enter user name and password.
› After log-in, the user name and the user icon are displayed.

› User + Access + Right matrix
Guest 

(Anonymous, 
no need to 

login)

Monitor Operator Admin Service

Access to the 
Process view  Read-only  Read-only  Full access  Full access  Full access

Access to the List 
view  Read-only  Read-only  Read-only  Read-only  Read-only

Access to the 
Trend view  Read-only  Full access  Full access  Full access  Full access

Access to the 
Setup view  Read-only  Read-only  Full access  Full access  Full access

Access to the 
Maintenance 
view

 Read-only

 Sensor 
calibration

 Pump 
calibration

 Sensor calibration
 Pump calibration
 Controller parame-

ters

 Sensor calibra-
tion

 Pump calibra-
tion

 Controller 
parameters

Access to the Ap-
plication settings  Read-only  Full access  Full access  Full access

Access to the 
System settings

 Factory reset
 Save setting
 Upload setting
 Database backup
 Database restore
 Chang device type
 Change logging level
 Change number of 

log file to keep
 Enable/disable 

21-CFR mode

 Full access

Access to the User 
Management  Full access  Full access

Start / Stop process  Full access  Full access  Full access
Access user-self 
information  Read-only  Full access  Full access  Full access

Access to deleted/
archived data

 Access switch 
button to show 
/ hide archived 
recipe and 
historical data

Safe stop button  Read-only  Full access  Full access  Full access
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2.5.3 Stirrer Control
› Mode:

- Off: Turn off the stirrer
- Manual: Set the stirring speed manually (independent of other parameters).
- Cascade – DO control: Stirrer control by DO cascade controller. Only the stirring direction 

can be set here.
- Profile: Preset of up to 10 values, which are run within a certain time period.
- Chaotic: Set the upper and lower speed limits and duration for the chaotic stirring. This 

is based on an algorithm that randomly calculates the speed within a defined frame. The 
algorithm is used to optimize the stirring time.

1 2

43

2.5.4 Gas Control (Air, O2, N2, CO2)
› Mode:

- Off: Turn off the gas module
- Manual: Set the gas flow rate manually (independent of other parameters).
- Cascade – DO control: Gas control by DO cascade controller.
- Profile: Preset of up to 10 values, which are run within a certain time period.

1 2

3
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2.5.5 Gas Mixer (Air, O2)
› Gas Mixer: Set Air and O2 control mode to Manual mode.
› If the Gas Mixer is enabled the set point input from Air and O2 control will be disabled.
› Set flow: Enter flow rate in vvm (Volume Vessel per Minute), up to 2 vvm.
› Set ratio (Slider): Change the mixing ratio of Air and O2. 

2.5.6 Pump Control
› Mode:

- Off: Turn off 
- Manual: Set flow rate, volume and rotation direction of the pump manually.
- Auto – pH control: The pump volume will be controlled by the pH controller. The pump 

speed and direction can be adjusted in this mode.
- Profile: Preset of up to 10 values to be run within a certain time period.

› Calibration information: 
 Show calibration information: If the parameters (for example the hose size used) are out of 

range, a recalibration should be performed.
- Calibrate: Pump or hose calibration
- Filling: (pre) filling of the hose

1 2

3

› Tubing filling
1. Before the calibration, select pump "Filling"
2. Click "Filling"
3. Choose "Tubing ID"

2

3

4

5
6

1

4. Input "Tubing length" in cm
5. Start "Filling"
6. Wait until "Filling" is completed
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2.5.7 Exhaust Control
› Mode:

- Off: Turn off
- Auto: The controller will automatically control the filter heating temperature according to 

the setpoint value.

2.5.9 Level limit Control
› Mode:

- Off: The sensor will detect the level but will not take any further action.
- Auto: If the level limit is detected, the controller will turn on the level pump to feed / 

harvest the medium.
› On delay: The time delay after the level sensor is active and before the Level pump Feed / Harvest.
› On time: Duration for pumping.
› Sensitivity: Adjust the sensitivity of the level detection sensor. 
› Status Indicator: Sensor status indicator (Normal / Activate).
› Level control mode: Control the pump direction (Harvest: suck out / Feed: Fill-in)

2.5.8 Foam limit Control
› Mode:

- Off: The foam sensor will detect the foam level but will not take any further action.
- Auto: If foam is detected the controller will turn on the Anti-foam pump to add Anti-foam 

agent.
› On delay: Anti Foam pump delay time
› On time: Anti Foam pump switch-on time
› Sensitivity: Adjust the sensitivity of the foam detection sensor.
› Status Indicator: Sensor status indicator (Normal / Activate).
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2.5.10 Temperature Control
› Mode:

- Off: Turn off
- Auto-Control: Reactor temperature control according to the setpoint specification.
- Profile: Preset of up to 10 values to be run within a certain time period.

› Set value offset:  Input of a temperature offset value
› Actuator: Select Heat blanket / Thermostat (IKA HRC 2) to control the temperature of the 

reactor vessel.

2.5.11 pH Control
› Mode:

- Off: Turn off
- Auto: Control process pH value according to the setpoint specification by activating the 

acid and base pumps, if these have also been set to "auto".
- Profile: Preset of up to 10 values to be run within a certain time period.

› Set value offset: Input of a pH value offset value.

2.5.12 pO2 Control 
› Mode:

- Off: Turn off
- Manual: Control the output power (%) of the pO2 controller directly with the Cascade 

control setting in the setup.
- Auto: Enter pO2 value (% saturate) with the Cascade control setting in the setup.
- Profile: Preset of up to 10 values to be run within a specified time period.

› pO2 Cascading: Graphical visualization of the cascade control values.

1 2

3
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2.6 Setup (Recipe) Menu
› Create, save and restore the setup:

- Reuse the previous configurations for the experiment. 
- Generate the experiment report after the experiment is finished.
- Visualization of the process view (for example reactor type, gas, pumps and accessories).

IMPORTANT:
› One of the saved setups must be assigned to every experiment before starting!

2.6.1 General
1  Select experiment mode (Batch, Fed-batch and Continuous)
2  Select data recording interval
3  Select data saving location: internal control unit, internal or external memory, e.g. USB stick 
4  Note: Enter notes or information for the setup.
5  Load the setup from the device
6  Save the current setup in the device
7  Reset all settings to default values

1

2

3

5 76

4

2.6.2 Reactor
1  Reactor vessel type and size
 (To effect min/max limits of parameter such as Gas flow rate and reactor vessel visualization)
2  Sparger type (only for the report)
3  Stirrer type (only for the report) 
4  Number of stirrers (for visualization and report)
5  Filter size (only for the report)
6  Spin filter size (only for the report)
7  Baffles enable / disable (for visualization and report)
8  Harvest pipe enable / disable (for visualization and report)
9  Cooling finger enable / disable (for visualization and report)

1

2

3

4

5

6

7

8

9
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2.6.3 Pumps
› The control unit consists of 4 built-in pumps: Pump A (top) to Pump D (bottom). 
› It is also possible to add an external pump called Ext A.
1  To enable / disable the pump. A disabled pump will not be shown and can not be controlled. 
2  Combo box is used to assign the parameters to the pump (Acid, Base, Anti-foam, Level and 

Substrate / Feed)

1 2

2.6.4 Gases
1  Enable / Disable up to 4 gas modules for the experiment. 
2  Enable / Disable the Gas Mixer (Air, O2). When the Gas mixer is enabled the flow rate of Air 

and O2 is controlled by the Gas mixer.

1

2
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1

4
2

3

5

2.6.5 Controllers
2.6.5.1 pO2 controller
1  Enable / Disable parameters to control the pO2 value 
2  Cascade table to control the pO2 value
3  Plus / Minus button: add / remove table rows (min. 2 / max. 6)
4  Apply button: assign the edited table to the device. (This is useful during experiment running 

if the user would like to update to new control strategy or to find a proper strategy before 
adding it into the recipe.)

5  Select the output path 
 (Information for the report: Which gas feed was selected)

2.6.5.1.1 DO cascade control (only) with the stirrer
› To have the DO control by the stirrer speed adjustment, and then the constant flowrate for 

the gas input.
› Set the “DO cascade table”
1  Select the tab "Setup recipe"
2  Select the "Controllers"
3  Select the tab "pO2"
4  Enable the "Cascading to Stirrer"
5  Define the "minimum speed", ROW-0%
 Define the "maximum speed", ROW-20%
6  Click "Apply" to save the settings

› Operating the pO2 control in “Auto” mode. 
1  Open the "pO2" module
2  Select the mode "Auto"
3  Define the set DO value (minimum control level), unit: %sat
4  Define the "offset +/-" (acceptable tolerance)

1 3

4

2

5

6

1

2

3

4
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› Operating the Stirrer in “Cascade - DO control” mode
1  Open the "Stirrer" module
2  Select the mode "Cascade – DO control"
3  Click "Apply" or "Ok" to save the settings

› Operating the Gas module in “Manual” mode
1  Open the "Air" module
2  Select the mode "Manual"
3  Define the flow rate setpoint value, unit: cc/min
4  Click "Apply" or "Ok" to save the settings
NOTE: If another gas is required, repeat the first step for O2, N2, or CO2 module.

1

2

3

1
2

3

4

2.6.5.1.2 DO cascade control by the stirrer and the gas flowrate adjustment
› Set the “DO cascade table”
 Option 1: To have DO control by stirrer speed and Gas flowrate adjustment in the same time.
1  Select the tab "Setup recipe"
2  Select the "Controllers"
3  Select the tab "pO2"
4  Enable the "Cascading to Stirrer"
5  Enable the "Cascading to Air, O2, or N2 (if needed)"
6  Define the "minimum Stirrer speed", ROW-0%
 Define the "maximum Stirrer speed", ROW-20%
7  Define the "minimum Air flowrate", ROW-0%
 Define the "maximum Air flowrate", ROW-20%
8  Click "Apply" to save the settings

1

2

4

8

76

3

5
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 Option 2: To have DO control by stirrer speed as the first step, and then the gas flowrate 
adjustment in the second step.

1  Select the tab “Setup recipe”
2  Select the “Controllers”
3  Select the tab “pO2”
4  Enable the “Cascading to Stirrer”
5  Enable the “Cascading to Air, O2, or N2 (if needed)"
6  Define the "minimum Stirrer speed", ROW-0%
 Define the "maximum Stirrer speed", ROW-20% & ROW-40%
7  Define the "minimum Air flowrate", ROW-0% & ROW-20%
 Define the "maximum Air flowrate", ROW-40%
8  Click "Apply" to save the settings

1

2

3

4

5

6 7

8

› Operating the PO2 control in “Auto” mode
1  Open the "pO2" module
2  Select the mode "Auto"
3  Define the set DO value (minimum control level), unit: %sat
4  Define "offset +/-" (acceptable tolerance)
5  Click "Apply" or "Ok" to save the settings

› Operating the stirrer in “Cascade - DO control” mode
1  Open the "Stirrer" module
2  Select the "Cascade – DO control"
3  Click "Apply" or "Ok" to save the settings

1

2

3

4

5

1

2

3
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› Operating the Gas in “Cascade - DO control” mode
1  Open the "Air“ module
2  Select the mode ”Cascade – DO control“
3  Click ”Apply“ or ”Ok“ to save the settings
NOTE: If another gas is required, repeat the first step for O2 or N2 module.

Important Note
How does the automatic DO control work in the background?
› The user defines the DO %sat (minimum control level) as the setpoint value.
› The DO controller will calculate a proper %Output value using the PID algorithm.

-  0.0 % Output: actual DO %sat is higher than or equal to the setpoint value.
-  0.1 - 100 % Output: actual DO %sat is lower than the setpoint value.

› The %Output is used to calculate the setpoint value for each sub-controller within the cas-
cade.

1

2

3

2.6.5.2 pH controller
1  Enable / Disable the parameters to control the pH value
2  Select the output path

› pH control

1

2

Base
 solution

Acid 
solution

pH control

Automatic DO control

0% 20% 40% 60% 80% 100%
280 280 280 280 420 560

 0 50 500 250 250 250

 0   0   0 250 250 250

500   0   0   0   0   0

0% 20% 40% 60% 80% 100%

0% 20% 40% 60% 80% 100%

0% 20% 40% 60% 80% 100%

Setpoint DO %sat 
DO controller Process

Process variable (DO %sat)

Stirrer Controller

Air controller

O  controller

N  controller

Output
(0~100%)
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› pH control with ACID and BASE pump
› Setting “Auto – pH control” for ACID and BASE pump
1  Open the "Acid" pump module
2  Select the mode "Auto – pH control"
3  Define pump flowrate (min. and max. values depend on the tube size), unit: cc/min 
4  Select a proper direction: CW or CCW 

5  Open the "Base" pump module
6  Select the mode "Auto – pH control"
7  Define the pump flowrate (min. and max. values depend on the tube size), unit: cc/min 
8  Select a proper direction: CW or CCW

1
2

3

4

5

6

7

8

Note:
cw = clockwise
ccw = counter clockwise

› Setting mode “Auto” for pH module
1  Open the "pH" module
2  Select the mode "Auto"
3  Define pH set value.
4  Define "offset +/-" (acceptable tolerance)

Important NOTE:
How does the automatic pH control work in the background?
› The user defines the pH set-value as setpoint input for the system.
› The controller determines the difference between the setpoint and actual values measured 

with the pH sensor.
-  If the actual pH value is within the range of the setpoint (incl. +/- offset), no action is initiated.
-  If the actual pH value is out of the range of the setpoint value (incl. +/- offset) the PID con-

troller calculates the necessary supply of ACID or BASE within a cycle of 30 seconds.

1

2

3

4

pH sensor Actual pH 
value

Feedback
∑

pH set value

Yes

In +/- “Offset” range?

PID calculation

“Feed duration” control
in cycle time of 30 sec

% output PID

No

ACID

BASE

Base
 solution

Acid 
solution

ACID

BASE

Automatic pH control
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2.6.6 Cell & Medium information
1  Input of cell / product information
2  Input of culture medium information 
3  Input of supplement information

1

2

3

2.6.7 Accessories & Option
1  Enable / Disable Light panel 
2  Enable / Disable CO2 sensor
3  Enable / Disable Conductivity sensor
4  Enable / Disable Turbidity sensor
5  Enable / Disable External signal module
6  Enable / Disable External signal module

2.6.8 Loading a recipe
1  Table to display all the recipes 
2  Column overview with sorting function (ascending or descending)
3  Button to delete the selected recipes
4  Selected column to filter the recipes
5  Input of the filter keywords to filter the recipes
6  Button to load the selected recipes

1

2

3

4

5

6

4
5

2

6

3

1



88 89

2.7 List View Menu
› Table view of all parameters:

- Actual value
- Set value
- Unit
- Operating mode
- Alarm conditions
- Alarm status
- Error codes

2.8 Trend View Menu
› Graphical display of current data.
› Data is updated when the software is connected to the IKA HABITAT or when the device 

time is changed.
› For data synchronization, click the Sync button. (Only when the experiment is running, there 

is no data when the experiment is not running).
1  Display all current parameter values (click to adjust the color and the scale).
2  Change the updating time of the graph
3  Freeze graph display (click to view the data, no new data will be added) 
4  Graph synchronization button
 To transfer all the data from the device to the software, as the device can be operated with-

out an active user interface.
 BE AWARE: Depending on the data size of the experiment it may take some time!
5  Click in the area of the graph to display a cursor line (display of all the values in this area)

1 2 3 4

5
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1  Enable / Disable Trend display
2   Select the parameters to be displayed
3  Select the color
4  Enable / Disable the function of auto scaling 
5  Set the minimum Y-Axis scaling
6  Set the maximum Y-Axis scaling

1

2

3
4

5

6

2.9 Historical data 
1  Table view of all the experiments
2  Graph display of historical data series
3   Button to export graphical data (PNG format)
4  Graph legend, click to show / hide
5  Button to print the graph
6  Button to export data as CSV file
7  Button to create a PDF file
8  Button to save data to USB drive connected to the control unit
9  Button to open the Filter menu
10  Button to delete the selected experiment
11 Table menu bar to sort the data (ascending / descending) 

1

2

3

4

5
6
7
8

9

11

10
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2.10 Alarm view
› The screen shows the alarm messages for the running experiment. If no experiment is run-

ning, the alarm messages will not be recorded.
› The alarm messages of each experiment will be saved and listed with the experiment data in 

the report.
1  Table menu bar to sort the data (ascending or descending)
2  Ascending or descending markers for the sorting

21

2.11 Maintenance Menu
2.11.1 Sensor Calibration 
1  Date / time of last calibration
2  Sensor serial number
3  Sensor raw value at zero point calibration
4  Sensor raw value during slope calibration
5  Probe condition: Minus sign means that the sensor is no longer suitable for further experi-

ments and should be replaced.
6  CAL button to start the calibration process

1 2 3 4 5 6
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2.11.2 Pump Calibration 
1  Date / time of last calibration
2  Tubing inner diameter.
3  Set value of the last pump calibration
4  The value that can be measured by the device when the user specifies a setpoint value.
5  Calibration constant (internal value for setting the pump accuracy)
6  CAL button to start the calibration process
 Filling button: used to fill an empty tube before calibration, also useful to use before and 

after the experiment.

1 2 3 4 5 6

2.11.3 Controller
› This menu is intended for the experienced users with knowledge of PID controller systems to 

enter their own PID controller parameters.
1  kp constant for the PID controller. 
2  ki constant for the PID controller.
3  kd constant for the PID controller.
4 Button to reset the PID controller parameters to default values
5  Temperature controller simulation:
 To simulate the PID controller with the modified kp, ki and kd control parameters.

1 2 3 4

5
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2.12 Settings Menu
2.12.1 General 
1  Change the device name
2  Select the user language
3  Select the device time zone.
4  Set the flow rate unit
5  Data downsampling Algorithm

- Average: All data within a 15 minute cycle will be averaged and displayed as one point.
- LTTB: The algorithm will keep all peaks and valleys of the graph before downsampling to 

display all data in the original.
6  Enable / Disable Auto Restart on power failure. The duration of the power failure can be set.

1

2

3

4

5

6

2.12.2 Alarm setting 
1  Enable / Disable alarm limits
2  Lower limit: If the actual value is lower than the lower limit, an alarm will be triggered.
3  Higher limit: If the actual value is higher than the higher limit, an alarm will be triggered.

1 2 3
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2.12.3 System 

!  Notice!
› This section should be used carefully!
› The menu allows to change the system parameters, delete or restore configurations that  

may not be compatible with the device!
› Access to this menu is reserved for Admin Level users!
› However, some menus require IKA service permissions with a service password to access and 

change the parameters.
1  Restore factory default configuration.
2  Export the current JSON file.
3  Import a JSON file and upload new device configurations.
4  Change the device type.
 Only for IKA Service!
 The changing of the device type is necessary if new device components or PCBs have been 

added.
5  This function is only for IKA Service.
6  This function is only for IKA Service.

1

2

3

4

5

6

2.13 Info Menu
1  About: HABITAT device information
2  IKA Cloud: Registration information for the IKA cloud
3  Manual: Open HABITAT operating instructions
4  Video Users guides: Link to YouTube Turtorial Videos
5  Shop: Link to HABITAT product page on IKA homepage

1
2

3
4 

5
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/// Autoclaving

   Danger!
› After autoclaving: Be aware of the hot surfaces!
› During autoclaving, there must be no water in the condenser. Fill the condenser with water 

only after autoclaving! For autoclaving remove the filling screw of the condenser.

 Caution!
› Check that the reactor vessel fits the autoclave device!
› Avoid overpressure in the system during autoclaving!
› Keep at least one connection port on the lid open during autoclaving!
› Keep the exhaust filters open. 
› For double-walled reactor vessels, keep the water connections of the double jacket open!

Steps for autoclaving
› Place the reactor vessel in the reactor vessel stand, and then close and fasten the lid!
› Mount the components / sensors to the lid.
› Fill medium into the reactor vessel (if you use a double-walled reactor, do not fill water into 

the double jacket).
› Remove the sensor cables.
› Remove the motor.
› Close the caps to protect the sensor connectors.
› Cover the sensor connections.
› Use caps, clamps or aluminium foil to cover the connections.
› Carry the reactor vessel only by the carrying handles on the reactor vessel stand!
› Place the reactor vessel with the reactor vessel stand in the autoclave (e.g. 25 ... 30 minutes 

at 121 °C, liquid cycle).
› After autoclaving, wait until the system cools down.

› Before autoclaving, please remove the motor and keep the connectors of double-walled 
glass vessel open!

› During autoclaving, there must be no water in the condenser. Fill the condenser with water 
only after autoclaving! For autoclaving remove the filling screw of the condenser.

Exhaust filter

Inoculation

Cooling figure

Reverse

Reverse

pH

Water connector

Water connector

Ba�e

Sparger

Harvest

Coupling

Temp

4 in 1
DO

Level

Leave it open

Closed port
Covered with foil

Autoclaving

safe
STOP

rpm Temp pH Do Level Foam

Autoclaving

Autoclaving

Keep open

Autoclaving

Autoclaving
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› Blow torch flame over the coupling to sterilize again before opening it for inoculation.
› There are different options for the inoculation:

- Use a syringe and the septum port. Pierce the syringe needle through the septum port.
- Open the port and add the liquid directly under the laminar flow hood.

/// Inoculation
› There are different methods for harvesting or emptying the reactor vessels:

- Direct pouring into an empty vessel or transferring to another vessel under the laminar flow 
hood. 

- Connect the sterilized silicone tubing to the harvesting tube and pump it into a prepared 
container using the peristaltic pump. This method is recommended for the viscous cell.

- Apply overpressure to the vessel. This method can be used if the harvesting hose is used. 
First, clamp the hose to block the escaping gas. Then turn on the gas flow system (maxi-
mum pressure 1.5 bar) and slowly adjust the flow rate.

/// Harvesting

/// Sampling

Replace septum Inoculation

15 mm Plug

Collar

Hub

Pipe

18 mm

10 mm

10 mm
O-ring

hold

1.

2.

3.
4.

1. 1.

2.

3.4.

5.

hold

1. hold

Inoculation

Harvest pipe

HA.sam (Syringe set)

Sampling
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The device can be operated by computer via an RS 232 or USB port using labworldsoft® labo-
ratory software. 
The device software can also be updated with a PC via the RS 232 or USB port.
Note: Please comply with the system requirements together with the operating instructions 
and help section included with the software.

/// USB interface
The Universal Serial Bus (USB) is a serial bus for connecting the device to the PC. Equipped with 
USB devices can be connected to a PC during operation (hot plugging). Connected devices and 
their properties are automatically recognized. The USB port can also be used to update firmware.

/// USB device drivers
First, download the latest driver for IKA devices with USB port from: 
https://www.ika.com/ika/lws/download/usb-driver.zip 
Install the driver by running the setup file. Connect the IKA device through the USB data cable
to the PC. The data communication runs through a virtual COM port. 
Note: The USB driver is unnecessary for Windows 10 system. Don’t install it for Windows 10 
system!

/// RS 232 interface
Configuration
› The functions of the interface connections between the device and the automation system are 

chosen from the signals specified in EIA standard RS 232 in accordance with DIN 66 020 Part 1.
› For the electrical characteristics of the interface and the allocation of signal status, standard RS 

232 applies in accordance with DIN 66 259 Part 1.
› Transmission procedure: asynchronous character transmission in start-stop mode.
› Type of transmission: full duplex.
› Character format: character representation in accordance with data format in DIN 66 022 for 

start-stop mode. 1 start bit; 7 character bits; 1 parity bit (even); 1 stop bit.
› Transmission speed: 9600 bit/s.
› Data flow control: none
› Access procedure: data transfer from the device to the computer takes place only at the comput-

er’s request.

Interfaces and outputs
› PC 1.1 Cable: This cable is required to connect RS 232 port to a PC.

/// Connection between the device and the external devices

› USB Cable A – B: This cable is required to connect USB port to a PC.

PC

1
RxD 2
TxD 3

4
GND 5

1
2 RxD
3 TxD
4
5 GND

6
RTS 7
CTS 8

9

6
7 RTS
8 CTS
9

1

2

3

4

5

6

7
8

9

5

4

3

2

1

9

8
7

6

USB B USB A

/// Connection capability
› WiFi

BA C

GUI (Windows)

GUI (iOS App)

GUI (iOS App)

WiFi
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› Ethernet

› RS 232 / USB

D E

RS 232 USB

GUI (Windows)

GUI (Windows)

GUI (Windows)

GUI (Windows)

RS 232 / USB

Ethernet

Ethernet

Ethernet

Router & hub

Ethernet

GUI (Windows)

GUI (Windows)

F

› Ethernet + WiFi

Ethernet + WiFi

Ethernet

EthernetWiFi Router
GUI (Windows)

G

H

I

GUI 
(iOS App)

› Remote

Remote

Remote software installed

USB / WiFi / 
Ethernet / 
RS 232

Ethernet

Ethernet, WiFi
Ethernet

Internet

Internet

InternetInternet

J

K

L

Router & hub

WiFi, 3G / 4G

› VPN

VPN

Ethernet

Ethernet, WiFi

WiFi, 3G / 4G

Ethernet

Internet

Internet

Internet

Internet
M

N

O

Router & hub

VPN

› IKA Cloud

IKA Cloud

Ethernet

Internet

Internet

P

Router & hub or

or

or

IKA Cloud
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/// Maintenance Checklist

Maintenance and cleaning

Component Check Before 
use

Note

Reactor vessel
Visual inspection X

› Don‘t use if there are any visible cracks or 
damages

› Replace if necessary

Hoses (gas & liquids)
Visual inspection X

› Don‘t use if there are any visible cracks or 
damages

› Replace if necessary

Electrical components 
(Motor, Heating jacket, 
Sensors…)

Visual inspection X
› Don‘t use if there are any visible cracks or 

damages

› Replace if necessary

Sealings, O-Rings (con-
nectors and stirrer shaft 
coupling)

Visual inspection X
› Don‘t use if there are any visible cracks or 

damages

› Replace if necessary

Filters
Visual inspection X

› Don‘t use if there are any visible cracks or 
damages

› Replace if necessary

Other components made 
of glass Visual inspection X

› Don‘t use if there are any visible cracks or 
damages

› Replace if necessary

pH- and DO- sensors

Visual inspection
Calibration

X

› Don‘t use if there are any visible cracks or 
damages

› Replace if necessary 

› Refer to software, use calibration guide

Foam- and Level- sensors Adjust sensitivity X

› For accessories see www.ika.com.

Accessories

/// Cleaning

   › For cleaning disconnect the mains plug!
  › Use only cleaning agents which have been approved by IKA to clean IKA devices:
 Water containing surfactant / isopropyl alcohol.
   › Wear protective gloves during cleaning the devices.
   › Electrical devices may not be placed in the cleansing agent for the purpose of cleaning.
   › Do not allow moisture to get into the device when cleaning.
   › Before using another than the recommended method for cleaning or decontamination, the 

user must ascertain with IKA that this method does not destroy the device.
   › For parts in contact with medium, please take them for the autoclaving after the cleaning!

/// Ordering spare parts

   › When ordering spare parts, please give:
- device type.
   - serial number, see type plate.
   - position number and description of spare part, see www.ika.com.
- software version.

/// Repairs

   › Please only send devices in for repair that have been cleaned and are free of materials which 
might present health hazards.

   › For repair, please request the “Safety Declaration (Decontamination Certificate)” from 
IKA or use the download printout of it from IKA website at www.ika.com.

   › If your appliance requires repair, return it in its original packaging. Storage packaging is not 
sufficient when sending the device - also use appropriate transport packaging.
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Error codes

   › The fault is shown by an error code on the display as following if the error occurs.
 Proceed as follows in such cases:

- Turn off the device by using the mains switch.
- Carry out corrective measures.
- Restart the device.

Error code | Causes | Effect | Solutions

01290009 - Power Supply shutdown
Causes › AC Power failure

Effect › Device stops

Solutions › Check the AC power supply
› Check the fuses
› Contact customer service

01380615 - Stirring contact disconnected
Causes › No signal from motor

Effect › Stirrer off

Solutions › Check the motor cable
› Check the motor
› Contact customer service

01383610 - Stirring Speed blocked
Causes › Motor does not run

Effect › Stirrer motor off

Solutions › Check the cable connection
› Check the sensor
› Contact customer service

01392915 - Temperature Sensor disconnected
Causes › No signal from sensor

Effect › Display 0.0
› Temperature control is not active 

Solutions › Check the cable connection
› Check the sensor
› Contact customer service

01072915 - Dissolved Oxygen (DO) Sensor disconnected
Causes › No signal from sensor

Effect › Display 0.0
› DO control is not active

Solutions › Check the cable connection
› Check the sensor
› Contact customer service

01132915 - Foam Sensor disconnected
Causes › No signal from sensor

Effect › Foam control is not active

Solutions › Check the cable connection
› Check the sensor
› Contact customer service

/// Table "Error codes"

01172915 - Level Sensor disconnected
Causes › No signal from sensor

Effect › Level control is not active

Solutions › Check the cable connection
› Check the sensor
› Contact customer service

01140615 - Heater contact disconnected
Causes › No signal from Heater 

Effect › Heater off

Solutions › Check the heater cable
› Check the heater
› Contact customer service

01090615 - Exhaust (Filter Heater) contact disconnected
Causes › No signal from Filter heater

Effect › Filter heater off

Solutions › Check the filter heater cable
› Check the filter heater
› Contact customer service

01011315 - Air Flow disconnected
Causes › No gas input

Effect › Air control is not active

Solutions › Check the gas supply and tubing
› Contact customer service

01261315 - Oxygen (O2) Flow disconnected
Causes › No gas input

Effect › O2 control is not active

Solutions › Check the gas supply and tubing
› Contact customer service

01021315 - Carbon dioxide (CO2) Flow disconnected
Causes › No gas input

Effect › CO2 control is not active

Solutions › Check the gas supply and tubing
› Contact customer service

01251315 - Nitrogen (N2) Flow disconnected
Causes › No gas input

Effect › N2 control is not active.

Solutions › Check the gas supply and tubing
› Contact customer service

01563610 - Pump A Speed blocked
Causes › Pump A does not run

Effect › Pump A stops

Solutions › Visual inspection of the pump head
› Open the pump head and perform a test
› Contact customer service
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› If the actions described fails to resolve the fault or another error code is displayed then take one 
of the following steps:
- Contact the service department.
- Send the device for repair, including a short description of the fault.

1.1 Stirrer
1.1.1 Color status: 
› GREEN: Stirrer is working normally.
› ORANGE: Warning, actual value out of the alarm limits
› RED: An error has occurred.
› OFF: Stirrer motor cable is not connected.
1.1.2 Possible Error codes: 
› 01380615: Stirring contact disconnected / Check the motor and the motor cable.
› 01383610: Stirring Speed blocked / Check the motor and the drive shaft.
› 01382708: Stirring Safety Circuit safety circuit cut-off / Contact customer service.
› 01383502: Stirring Setting upper limit / Check the alarm setting.
› 01383503: Stirring Setting lower limit / Check the alarm setting.

01573610 - Pump B Speed blocked
Causes › Pump B does not run

Effect › Pump B stops

Solutions › Visual inspection of the pump head
› Open the pump head and perform a test
› Contact customer service

01583610 - Pump C Speed blocked 
Causes › Pump C does not run

Effect › Pump C stops

Solutions › Visual inspection of the pump head
› Open the pump head and perform a test
› Contact customer service

01593610 - Pump D Speed blocked
Causes › Pump D does not run

Effect › Pump D stops

Solutions › Visual inspection of the pump head
› Open the pump head and perform a test
› Contact customer service

/// LED Status
1. Processing Status

IKA HABITAT

Stirrer Temp pH pO2 Level Foam

safe
STOP

2.

1.2 Temp
1.2.1 Color status: 
› GREEN: Temperature control is working normally.
› ORANGE: Warning, actual value out of the alarm limits
› RED: An error has occurred.
› OFF: Temperature sensor cable is not connected.
1.2.2 Possible Error codes: 
› 01392915: Temperature Sensor disconnected / Check the temperature sensor and the cable.
› 01393502: Temperature Setting upper limit / Check the alarm setting.
› 01393503: Temperature Setting lower limit / Check the alarm setting.
› 01140615: Heater contact disconnected / Check the heat blanket and the cable 
› 01142920: Heater Sensor fault / Contact customer service.
› 01143808: Heater Temperature safety circuit cut-off / Contact customer service.
› 01143824: Heater Temperature too high / Check the installation of the heat blanket on the vessel.

1.3 pH
1.3.1 Color status: 
› GREEN: pH control is working normally.
› ORANGE: Warning, actual value out of the alarm limits
› RED: An error has occurred.
1.3.2 Possible Error codes: 
› 01283502: pH Setting upper limit / Check the alarm setting.
› 01283503: pH Setting lower limit / Check the alarm setting.

1.4 pO2

1.4.1 Color status: 
› GREEN: pO2 control is working normally.
› ORANGE: Warning, actual value out of the alarm limits
› RED: An error has occurred.
› OFF: DO sensor cable is not connected.
1.4.2 Possible Error codes: 
› 01072915: Dissolved Oxygen (DO) Sensor disconnected / Check DO probe and cable.
› 01073502: Dissolved Oxygen (DO) Setting upper limit / Check the alarm setting.
› 01073503: Dissolved Oxygen (DO) Setting lower limit / Check the alarm setting.

1.5 Level
1.5.1 Color status: 
› GREEN: Level is normal
› RED: Level (max.) is reached
› OFF: Foam & Level sensor box is not connected.
1.5.2 Possible Error codes: 
› 01172915: Level Sensor disconnected / Check the cable connection to the control unit.
› 01172906: Level Sensor set value exceeded / Liquid has been detected by the sensor. 

1.6 Foam
1.6.1 Color status: 
› GREEN: Foaming is normal, within the detection area.
› RED: Foam has been detected.
› OFF: Foam & Level sensor box is not connected.
1.6.2 Possible Error codes: 
› 01132915: Foam Sensor disconnected / Check the cable connection to the control unit. 
› 01132906: Foam Sensor set value exceeded / Foam has been detected by the sensor.
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IKA HABITAT

Stirrer Temp pH pO2 Level Foam

safe
STOP

IKA HABITAT

Stirrer Temp pH pO2 Level Foam

safe
STOP

IKA HABITAT

Stirrer Temp pH pO2 Level Foam

safe
STOP

IKA HABITAT

Stirrer Temp pH pO2 Level Foam

safe
STOP

IKA HABITAT

Stirrer Temp pH pO2 Level Foam

safe
STOP

2.

1.

2. Interrupting Status
2.1 Emergency mode display 
› All 6 LEDs keep flashing in “RED”

2.2 Wi-Fi reset and initialization display 
2.21 Triple LED (left -right) are flashing in "GREEN" during Wi-Fi module reset and connection
        setup
2.22 Setup finished. Ready for Wi-Fi connection.

Technical data

Environment

Permissible ambient temperature +  5 ... +  40 °C

Permissible relative humidity 80% (up to 31 °C), decreasing linearly to max. 50 (@40 °C)

Permitted on-time 100 %

Protection class I

Contamination level 2

Overvoltage category II

Operation at a terrestrial altitude max. 2000 m

Control unit

Nominal voltage 100 ... 240 VAC

Frequency 50 / 60 Hz

Max. rated power 1100W

Nominal input power 300 W

Fuse  2x T5.0 A 250 V

Dimensions (W × D × H) 224 x 405 x 624 mm

Dimension (W × D) 189 x 345 mm

Material of housing Metal housing and PUR coated

Weight 14 kg

Protection class according to DIN EN 60529 IP 20

Motor direct coupling

0.5 L glass 1...1400 rpm
1 L glass: 1 ... 2000 rpm
2 L glass: 1 ... 2200 rpm
5 L glass: 1 ... 1500 rpm
10 L glass: 1 ... 800 rpm
3.0 L SU: 1 ... 500 rpm

System requirement
Window 10 or higher
iOS 7 or higher

Interface

USB
PC connect
RS 232
Ethernet
SU connect
Thermostat
Ext. pump
Ext. signal input 4 ... 20 mA
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Pump Module

Quantity 4 PC

Controller Variable speed (CW / CCW)

Flow rate
(Tube wall thickness 1.6 mm)

ID 0.5 mm: 0.3 ... 4 cc/min
ID 0.8 mm: 1.0 ... 12 cc/min
ID 1.2 mm: 1.6 ... 20 cc/min
ID 1.6 mm: 3.0 ... 45 cc/min
ID 2.4 mm: 7.0 ... 85 cc/min
ID 3.2 mm: 13.3 ... 140 cc/min
ID 4.8 mm: 26.6 ... 270 cc/min

Probe and controllers * is optional

Temperature
0 ... 100 °C
Display resolution: 0.1 °C

DO probe (Brand Hamilton)
Range 0 ... 200 %
Display resolution: 0.01 %

pH probe (Brand Hamilton)
Range 0 ... 14 pH
Display resolution: 0.01 pH

Foam Display: Norm. or Act.

Level Display: Norm. or Act.

*CO2 
Range 0 ... 100 %
Display resolution: 0.01 %

*Conductivity
Range 0.2 ... 400 ms/cm
Accuracy ± 5%

*Turbidity
Range 0 ... 250 g/L
Range 10 ... 4000 FTU

Aeration Module

Gas inlet
- Dry and oil free gases
- Maximum pressure 3.0 barg ±10 %

Gas outlet
- Maximum pressure 1.0 barg
    With safety relief valve 1.0 bar

Four gases system (Air, O2, N2 & CO2) for Cell culture
Automatic aeration control

Cell culture flow rate 0 ... 2 lpm

Fermentation flow rate 0 ... 20 lpm

Accuracy ±2% full scale

Temp control module in side vessel

Using heating jacket (single wall vessel) Room temp ... 60 °C

Using chiller (double wall vessel) 5 ... 80 °C

LED light panel

Type Flexible LED panel system, able to adjust brightness

Number of light panel Up to 4

Day & night simulation can be programmed

Vessel information

Unit
Glass 
vessel
0.5 L

Glass 
vessel

1 L

Glass 
vessel

2 L

Glass 
vessel

5 L

Glass 
vessel
10 L

Total volume l 0.8 1.6 3.00 6.7 12.9

Max. working volume l 0.5 1 2 5 10

Min. working volume l 0.25 0.30 0.60 1.0 2.0

Vessel inner diameter dv mm 90 110 130 160 190

Vessel height h mm 150 190 260 370 470

Ratio h/dv mm 1.67 1.73 2.00 2.31 2.47

Liquid height hL mm 85 110 160 265 370

Ratio hL/dv mm 0.94 1.0 1.23 1.66 1.95

Diameter 6-blade impeller di6 mm 33 40 48 57 68

Diameter 3-pitch blade 
impeller di3

mm 34 41 49 59 69

Ratio di6 / dv  (6-blade) mm 0.37 0.36 0.37 0.36 0.36

Ratio di3 / dv  (3-pitch blade) mm 0.38 0.37 0.38 0.37 0.36

Net weight assembled 
without media & accessories 
single wall

kg 6.4 7.87 9.11 13.29 -

Net weight assembled
without media & accessories
double wall

kg 6.77 8.09 10.55 15.66 21.9

Weight SU 2 L without 
holder

kg - - - - -

Weight SU 2 L with holder kg - - - - -
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Overall dimension (mm)

Vessel size Width Depth Height

Glass vessel 0.5 L 875 530 630

Glass vessel 1 L 900 530 630

Glass vessel 2 L 920 530 630

Glass vessel 5 L 950 530 675

Glass vessel 10 L 990 530 810

Width

D
ep

th

Th
er

m
os

ta
t

H
ei

gh
t

Space requirement for autoclaving (mm)

Vessel size Width Depth Height

Glass vessel 0.5 L 185 215 455

Glass vessel 1 L 210 240 505

Glass vessel 2 L 230 260 580

Glass vessel 5 L 260 290 695

Glass vessel 10 L 300 330 815

H
ei

gh
t

Width Depth
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Multiuse vessel

Material

Vessel Borosilicate glass 3.3

Components contact to medium Stainless steel 316

Components not contact to medium Stainless steel 304

Gasket EPDM

O-ring Silicone USP class VI

Hose for peristaltic pump

Material Silicone USP Class VI 

Size (ID x wall THK) 3.2 x 1.6 mm

Tube for air / gases

Material Silicone tube USP class VI

Size (ID x OD) 3.2 x 6.4 mm

Impeller type

Type 6-blades or 3-pitched blades

Flow characteristic Down or up flow

Sparger type

Micro sparger 5 micron

Ring sparger Hole diameter  0.5 mm

Air pump

Specification

Voltage 115 ... 230 VAC

Rated pressure 0.15 bar

Flow rate 80 Liter / min

Noise level 40 dB

Peltier Cooling

Type of cooling peltier or water cooling

Temperature min. / Condenser with Peltier 15 °C

Operating mode continuous operation

Auto restart after power failure yes

Dimensions (W x D x H) 90 x 250 x 70 mm

Weight 2 kg

Permissible ambient temperature + 5 ... + 40 °C

Permissible ambient conditions 80% (up to 31 °C), decreasing linearly to max. 50% (@40 °C)

Protection class according to 
DIN EN 60529

IP 20

Voltage 100 ... 240 V

Frequency 50 / 60 Hz

Power input 50 W

Power input max. 60 W

Fuse 2 x T5.0A 250 V
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PC requirements

Minimum Recommended

Operating system Windows 10, 32/64 bits Windows 10, 64 bits

Processor Intel® Core i3 8th generation (8109U) or 
above

Intel® Core i5 4th generation ( or an equi-
valent AMD processor)

Graphics card
Video adapter compatible with DirectX 9, 
WDDM driver support and minimum 128 
MB RAM

Video adapter compatible with DirectX 
10, WDDM driver support and minimum 
1 GB RAM

RAM 4 GB 8 GB

Storage HDD, minimum 15 GB free disk space SSD, minimum 50 GB free disk space

Display 1024 x 768 (XGA) 1920 x 1080 (FHD)

Peripherals

 Ethernet 10BASE-T Gigabit Ethernet

 WiFi 802.11a/b/g/n/ac 802.11a/b/g/n/ac

 Bluetooth 4.2 4.2

 USB USB 2.0 USB 3.0

 Serial port (optional) DB-9 connector DB-9 connector

Tablet requirements

Minimum Recommended

Operating system Running iOS 11 or later Running iOS 12 or later

Processor ARM: ARMv7-A or higher ARM: ARMv8-A or higher

RAM 2 GB 4 GB

Storage 32 GB 64 GB

Display 7 inch in diagonal, viewport ≥ 768 x 1024
10 inch in diagonal, viewport ≥ 768 x 
1024

Peripherals

 WiFi 802.11a/b/g/n/ac 802.11a/b/g/n/ac

 Bluetooth 4.2 4.2

Smart Phone requirements

Minimum Recommended

Operating system Running iOS 11 or later Running iOS 12 or later

Processor ARM: ARMv7-A or higher ARM: ARMv8-A or higher

RAM 2 GB 4 GB

Storage 32 GB 64 GB

Display 5.5 inch in diagonal, viewport ≥ 380 x 640
6.0 inch in diagonal, viewport ≥ 412 x 
732

Peripherals

 WiFi 802.11a/b/g/n/ac 802.11a/b/g/n/ac

 Bluetooth 4.2 4.2

 Subject to technical changes!

Warranty

› In accordance with IKA Terms and Conditions of Sale, the warranty period is 24 months. For 
claims under the warranty please contact your local dealer. You may also send the device 
direct to our factory, enclosing the delivery invoice and giving reasons for the claim. You will 
be liable for freight costs.

› The warranty does not cover worn out parts, glassware or sensors, nor does it apply to faults 
resulting from improper use, insufficient care or maintenance not carried out in accordance 
with the instructions in this operating manual.
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Technical specifications may be changed without prior notice. 

IKAworldwide IKAworldwide /// #lookattheblue @IKAworldwide

Discover and order the fascinating products of IKA online:
www.ika.com

JAPAN
IKA Japan K.K.
Phone: +81 6 6730 6781
eMail: info_japan@ika.ne.jp

VIETNAM
IKA Vietnam Company Limited
Phone: +84 28 38202142
eMail: sales.lab-vietnam@ika.com

INDIA
IKA India Private Limited
Phone: +91 80 26253 900
eMail: info@ika.in

UNITED KINGDOM
IKA England LTD.
Phone: +44 1865 986 162
eMail: sales.england@ika.com

MALAYSIA
IKA Works (Asia) Sdn Bhd
Phone: +60 3 6099-5666
eMail: sales.lab@ika.my

CHINA
IKA Works Guangzhou
Phone: +86 20 8222 6771
eMail: info@ika.cn

POLAND
IKA Poland Sp. z o.o.
Phone: +48 22 201 99 79
eMail: sales.poland@ika.com

USA
IKA Works, Inc.
Phone: +1 910 452-7059
eMail: sales@ika.net

KOREA
IKA Korea Ltd.
Phone: +82 2 2136 6800
eMail: sales-lab@ika.kr

BRAZIL
IKA Brasil
Phone: +55 19 3772 9600
eMail: sales@ika.net.br

IKA-Werke GmbH & Co. KG
Janke & Kunkel-Straße 10, 
79219 Staufen, Germany
Phone: +49 7633 831-0
eMail: sales@ika.de

THAILAND
IKA Works (Thailand) Co. Ltd.
Phone: +66 2059 4690
eMail: sales.lab-thailand@ika.com

TURKEY
IKA Turkey A.Ş.
Phone: +90 216 394 43 43
eMail: sales.turkey@ika.com


	EU Declaration of conformity
	Explication of warning symbols
	/// Warning symbols
	/// General Symbols

	Safety instructions
	/// General information
	/// Device design
	/// Working with the device
	/// Accessories
	/// Power supply / Switching off the device
	/// Maintenance
	/// Disposal instructions

	Intended use
	/// Use
	/// Area of use

	Unpacking
	/// Unpacking
	/// Scope of delivery

	Useful information
	Installation
	/// Gas
	/// Interfaces
	/// Vessel
	/// Lid
	/// Lid with plugs and fittings
	/// Drive shaft
	/// Impeller
	/// Harvest pipe
	/// Ring or micro sparger
	/// Baffle
	/// Condenser
	/// Level sensor
	/// Temperature sensor
	/// DO, pH, CO2, conductivity or turbidity probe
	/// Spin filter (accessories)
	/// Vessel and stand
	/// Lid and vessel
	/// Peltier cooling
	/// Motor
	/// Foam sensor
	/// Heat blanket
	/// Twist tie
	/// Pump tubing
	/// HA.ep External peristaltic pump (accessories)
	/// Hose connecting
	/// Connecting gas outlet to sparger
	/// Schematic view - 4 gases system
	/// Lid stand (accessories)

	Operation
	/// Switching on / off
	/// HABITAT "Quick start Guide"
	1. iOS Installation
	1.1 iPad Setup
	1.2 Installing the HABITAT app

	2. Getting start
	2.1 Initial commissioning and setup
	2.2 Logging in
	2.3 Setting the set points
	2.4 Changing "User ID" and "Password"
	2.5 Time synchronization
	2.6 Exit the application


	/// HABITAT "Software connect Guide"
	1. Software connect (Windows version)
	1.1 Components
	1.2 Connection (4 options)

	2. App connect (iOS version)
	2.1 Components
	2.2 Connection
	2.3 iPad cable connection

	3. HABITAT App connect (Android version)
	3.1 Components
	3.2 Connection


	/// Menu structure
	/// Menu navigation
	1. Screen Format
	1.1 Screen Layout Desktop / Tablet
	1.2 Screen Layout Mobile

	2. Screen List
	2.1 Screen of all available devices
	2.2 Connection screen
	2.3 Application Header Menu
	2.4 Application Bottom Menu
	2.5 Process view
	2.6 Setup (Recipe) Menu
	2.7 List View Menu
	2.8 Trend View Menu
	2.9 Historical data 
	2.10 Alarm view
	2.11 Maintenance Menu
	2.12 Settings Menu
	2.13 Info Menu


	/// Autoclaving
	/// Inoculation
	/// Harvesting
	/// Sampling

	Interfaces and outputs
	/// USB interface
	/// USB device drivers
	/// RS 232 interface
	/// Connection between the device and the external devices
	/// Connection capability

	Maintenance and cleaning
	/// Maintenance Checklist
	/// Cleaning
	/// Spare parts order
	/// Repair

	Accessories
	Error codes
	/// Table "Error codes"
	/// LED Status
	1. Processing Status
	1.1 Stirrer
	1.2 Temp
	1.3 pH
	1.4 pO2
	1.5 Level
	1.6 Foam

	2. Interrupting Status
	2.1 Emergency mode display 
	2.2 Wi-Fi reset and initialization display 



	Technical data
	Warranty

